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Licensing and Copyright Agreement

This software is Copyright ©1997-2016 TED and ©TRI-EDRE.

Except as permitted under copyright law, no part of the program or this manual may be reproduced or distributed in any form or by any means without the prior written
permission of TRI-EDRE.

The program, and this manual, are licensed only for individual use on a single computer. You are permitted by law to make working copies of the software program, solely for
your own use. No copy (original or working) may be used while any other copy is in use.

If you ever sell, lend, or give away the original copy of this Software program, all working copies must also be sold, lent, or given to the same person, or destroyed.

Limited Warranty

TRI-EDRE warrants to you that the Software will perform substantially in accordance with the Documentation for the ninety (90) day period following the date of delivery of the
Software to you. If the Software fails to meet the specifications of the warranty set forth above, TRI-EDRE liability and your exclusive remedy will be replacement of the CD or a
reasonable effort to make the product meet the above warranty specification. Except for the above express limited warranties, TRI-EDRE makes and you receive no warranties or
guarantees, express, implied, statutory or in any communication with you, and specifically disclaims any implied warranty of non infringement, merchantability or fitness for a
particular purpose. TRI-EDRE does not warrant that the operation of the program will be uninterrupted or error free.

In no event will TRI-EDRE be liable for any loss of use, loss of profits, interruption of business, or indirect, special, incidental or consequential damages of any kind, however
caused and under any head of liability, arising out of use of or in connection with the software.

Trademarks

Tri-BACKUP is a trademark of TRI-EDRE.

All other products are trademarks of their respective companies.

©TRI-EDRE. All Rights Reserved.

TRI-EDRE
22 Place de I'Eglise - 83510 LORGUES (FRANCE)
Web site: www.tri-edre.fr - www.tri-edre.com
Email address: contact@tri-edre.fr « contact@tri-edre.com
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Introduction

Welcome!

Thank you for your confidence in purchasing our backup software Tri-BACKUP 8! We are certain that you will find Tri-BACKUP 8 to be the essential tool to protect your data.
You can start by reading the next chapter, "Getting Started', if you are new to Tri-BACKUP.

Thank you for registering

Thank you for registering. You can receive free technical support and be informed of updates and developments of this product, and all the innovations of our production.
If you purchased our software on TRI-EDRE's web store (download purchase), you are automatically registered, and you do not need to register again.
If you purchased our software from a reseller or within a bundle, please use the registration page on our web site http://www.tri-edre.com.

License

You can purchase a license to fully use Tri-BACKUP (see our website). Licenses are available for the "Standard" and for the "Pro" version. A "single-user" license allows the
installation and simultaneous use on two machines. Multi-users licenses are available for use on a larger number of machines.

If you do not have a serial number, you can use Tri-BACKUP 8 in demo mode.

Latest version of the software

Check our website http://www.tri-edre.com to verify that you have the latest version of this software. If this is not the case, you may download the latest version which allows
you to use your serial number.

Note: serial numbers are compatible with all versions of the same main version number: a serial number for version 8.0 can be used with versions 8.1, 8.2, etc. A serial number from a
previous version (5, 6 or 7, for example) can not be used with Tri-BACKUP 8.

Note: Tri-BACKUP can check the latest available version and download it. See Preferences.

Software Installation

In the disk image you downloaded, the installer is "Tri-BACKUP 8 Installer". Double-click this installer and click the Install button.
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Uninstalling Software

Use the installer "Tri-BACKUP 8 Installer". Double-click this installer and click the Uninstall button.

Note: You can also uninstall Tri-BACKUP 8 from the application, with the Tools menu.
Note 2: If you just want to stop the operation of Tri-BACKUP in the background, open the Tri-BACKUP 8 Preferences and uncheck "Launch Tri-BACKUP Scheduler at startup".

Launch and Register Software

Double-click the application icon to launch it. At first launch, the application will ask you to enter the Administrator password (the one you use for each update of the system or
applications). Then, a dialog asks you to enter your serial number (provided by e-mail or mail when you purchased a license).

This serial number, that is personal, actives all the features of your software.

Keep your serial number in a safe place. You could need to access technical support or updates.

Trial version

At each launch, you will be asked for a serial number if your version is not registered. To use Tri-BACKUP 8 in demo mode, wait until the demo button is active. The demo version
is fully useable, but is time limited (and some functions could be limited).

You can enter the serial number at any time by selecting the Register item in the menu Tri-BACKUP 8 > License Registration.

Technical support

Above all, use this guide and the other guides, and our website to check all information on this product and its use. If you do not find the answer to your questions, please
contact our technical support by e-mail (see contact information below).

Please have your serial number, your version number, your OS X version and characteristics of your system ready before initiating contact.
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Contacts

If you have comments about this program, problems or issues that are not answered in this manual or on our website - or if you are interested in site licenses of software -
please contact TRI-EDRE (specifying the version and serial number of your copy):

by e-mail address:

contact@tri-edre.com
support@tri-edre.com

by mail:
TRI-EDRE
22 Place de I'Eglise
83510 Lorgues
France
Web site:

http://www.tri-edre.fr
http://www.tri-edre.com
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Getting Started

Tri-BACKUP offers a wide range of options to fit your needs. But first, here are some basic actions.

Make a bootable copy of your hard drive

Why?

A copy of your internal drive will allow you to restart immediately in case of problems, while keeping your environment, your applications and settings, without having to
reinstall the System or applications.

You also use a bootable copy if you need to change the disk from your Mac.
How?

You must have a second drive able to boot your Mac and with a compatible format (GUID Partition and Mac OS extended format). Create a "Bootable Copy" programmed action
and start running.

You can schedule the execution of the action to have it executed periodically, so that the copy is updated regularly.

Backup your data

Why?

The best protection of your data is to have a copy (the ideal is to have multiple copies stored in different places). In case of accidental deletion or loss, you can still use the data
from your backup.

Of course, it is important to have an updated backup. A backup that date a year ago has much less interest!

How?

You must have a backup disk. Create a "Copy Folder" action (to backup the contents of a single folder) or a "Mirror Backup" action (to backup multiple disks and folders in a
single operation), enter the folder or folders to backup (such as your "home" or your "Documents” and "Images", etc..) and set a regular schedule. The backup will be performed
automatically without needing your intervention.

What next?

You have now set up a basic protection of your data. You can then go further in the use of Tri-BACKUP to refine its action according to your needs.
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Basics

Backups

A backup is a copy of all or part of your data. If you lose the originals, you can use the copy.
Tri-BACKUP allows many ways of copying and backup to fit your needs.

Important: Tri-BACKUP copy your data by keeping the hierarchical organization of folders. The copy is identical to the original, and can be used and restored directly
from the Finder, without going through Tri-BACKUP.

Actions

For all operations (copy, backup etc..), you create an action and define the settings that suit your needs. Then, you launch the action manually (or set the automatic execution).

Tri-BACKUP offers "Programmed Actions" and "Immediate Actions".

The "Programmed Actions" have been designed to perform copy and backup operations transparently. They keep your settings (you do not have to redo the setting each
time) and run automatically (you can also run it manually). Their execution is done in the background and you can continue to use your computer during this time.

Note: The automatic execution may be programmed according to various criteria (frequency, the mounting of a disk or on quitting an application, etc.) and may be associated with
a context (home, office, nomad). You can choose certain actions to be executed only in the current context (for example, that certain actions execute at the office and not when your
computer is at home).

Note: The manual execution can be done from the Programmed Actions panel of Tri-BACKUP 8, but also from the Tri-BACKUP 8 Scheduler process, with the possibility of using quick
launch shortcuts.
The "Immediate Actions" were created to visualize, check and compare the contents of folders or disks, when you wish to check the content, or if you want to choose specific
files or folders to copy or treated.

You can create as many different actions as necessary.

The operation and organization of Tri-BACKUP

The Tri-BACKUP 8 application is used to create actions and define the operation.
Note: Once you have defined actions, you can quit Tri-BACKUP 8. The automatic execution of your actions will be managed by other applications described below.

The automatic execution of actions is managed by a process (a standalone application called "Tri-BACKUP 8 Scheduler" or Scheduler) that runs continuously in the
background and launch actions based on what you decided. This process displays a small icon in the menu bar.
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The execution of the programmed actions uses another standalone application called "Tri-BACKUP 8 Execute".

The documentation for Tri-BACKUP 8

This guide in PDF format can be opened from the application (Help menu). You can also download this documentation on our website.

In addition, you have in the application multiple context-sensitive help panels.
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Strategy for your backups

Why save?

The computers and disks are reliable, but sometimes fall down. In addition we can make mistakes and accidentally delete data. Finally a computer or a disk can be destroyed or
stolen.

We must bear in mind that the data in our computer are not completely safe. If the data have any significance, we must save them (in other words, keep copies).

In addition, a copy of your hard drive can save a lot of time in case of failure, because you can immediately restart the copy to continue using the computer without having to
reinstall everything.

Where to Backup?

You can back up to any media that mounts on the Mac Desktop, as the disks internal or external, networked disks, etc.

Usable format
The format of the disk must be suitable for your need. For example, to make a bootable copy on Mac, the format of the disk to copy must be HFS extended or APFS.

Preferably use an Apple format, but you can also save on other formats (MSDOS, etc.).

Using a disk image

You can use disk images for backups, either disk images of fixed size (with the extension .dmg) or images whose size is automatically adapted to the content (type
"sparsebundle”).

The disk images are practical, for example to keep several versions of the original disk on a same disk volume, to archive a backup, to encrypt backups, etc.
Disk images can be created with the application "Disk utility" located in /Applications/Utilities/.

Note that you can create a "bootable" copy on a disk image to restore a disk, but you cannot directly boot from the disk image.

What to Backup?

The answer to this question is closely related to your use of the computer. It will not be the same if you use a computer to surf the internet, if you keep your personal data
(photos, etc.), or if it is your work tool and it contains many data you have created.

Here are some questions to consider (not exhaustive):
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If lost, what data | can easily retrieve or reconstruct (eg, applications and data that can be found easily on the internet) and what data would be unrecoverable (the
photos of an exceptional event, the project you are working, your creations, etc.).?

The answer to this question, you'll know what to absolutely save.

How important is this data?

For important data, you will have to heart to save regularly and keep multiple copies in several locations.
What time do | will save with a backup?

For some data that could be found and reinstalled, you can choose to make a copy that will save time. This is for example the case of a copy of the primary disk, immediately
usable in case of problems.

What is the ratio of security / cost for me?

We increase the security of data by multiplying backups and medias (disks, etc..), which has a cost. The choice will not be the same for a company whose data is vital, for a
professional who has all his work on his computer or a casual user.

What to backup at least?

At least save the contents of your "House" (the folder containing all the data for the current user) because there are grouped your data and all your settings.

Where to store backups?

Obviously keep its backups next to his computer is good security in case of problems with the computer, but not in case of burglary or fire.
For important data, you have to think to have other copies in other locations (hard drives stored in different locations, online backups, etc.).

Note: It is of course possible to encrypt a disk or data if you wish them to remain accessible only to authorized persons.

The copy of your hard drive

Make a copy of your startup disk to restart quickly, with your usual environment, your settings, your applications and documents, if something goes wrong with your hard drive.
It is also a very simple solution if you want to replace the drive of your computer.

Tri-BACKUP can make copies of your disks, including complete and bootable copy of a disk containing a System. You can easily set the periodic execution of such a copy action,
so that the copy is updated regularly and automatically and remains identical to the original. For this, use a Bootable Copy programmed action.

What type of backup to use?

Tri-BACKUP allows several types of backups to suit all needs.

The bootable copy of a disk can be used to create an emergency disk.
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The folder copy copies all the contents of a folder or a disk.
The backup mirror provides an identical copy of one or more disks or folders and then easily retrieve a specific document or an entire file after an accident or loss of files.
Note: Caution! Any "mistake" made in the original (damaged, modified or deleted item) is reflected in the copy during the next backup.

The evolutive backup creates an identical copy of one or more disks or folders, and keeps the successive versions of each document. So you can retrieve an older version of a
document or folder.

Note: This backup type requires more space than a mirror backup and grows gradually as backups are executed.
The incremental backup backs up all or part of one or more disks or folders into a new folder each time. You keep the successive versions of a document or an entire disk.

You can combine these different types of backup. Use evolutive backup to save your entire disk, or files particularly valuable. You can use the incremental backup for current
projects (the data you are working regularly).

Create configurations for each backup

It is better, more flexible and more efficient to create multiple configurations rather than a single backup of all your data. Indeed, some data are more important than others,
some are changed very often and others rarely, and so on.

Use the possibility to create multiple configurations to optimize your backup strategy. It will take less time and occupy less space.

Also made from time to time, global backups and when it makes sense, schedule frequent backups of your important files or sensitive data (clients, projects you're working on
right now, etc.).

Backup multiple networked computers

Tri-BACKUP lets you backup all volumes mounted on the desktop. You can, from your desktop, save the contents of the disks of other computers on your network, possibly with
different configurations for each machine.

You can also reserve a disk on a server for backups of all machines in your network. In this case, each machine will have its own backup folder.

Examples of use

Here's how | use Tri-BACKUP, in association with multiple internal disks, several external hard drives, space on web servers, and use of services like Dropbox.

Copy of the primary disk: Very important! To be able to restart quickly if something goes wrong, | have a copy of my primary drive, which is updated regularly (every day). In
fact, | have several copies physically stored in different places.

Copy of current work: Regular copies of documents, with keeping of older versions. The disk where the copy is made is itself backed up and multiple copies are kept in
different places.

Backups of my pictures: The size of these data is more important and are managed separately, but also there with several copies in different locations.
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Backups on the Internet: Regular copies of data on the Internet (encrypted). The size of these data is limited because internet does not (currently) allow easy transfer of large
volumes of data. The data is encrypted to increase their protection. This is a copy of last chance, if no other copies would recover the data.

Transfer and data synchronization: Actions regularly update the data between different machines, using the local network.

Transfer and data synchronization between two remote disks: Actions allow you to use a portable disk (even smaller than the disks to be synchronized) to compare the
disks and copy the differences.

Data transfer via the Internet: Some synchronization of data between machines that are not on the same geographical location go through internet. Copy of encrypted data
on a web server, and recovery and decryption on an other machine.

Using transfer services such as Dropbox: Data is stored in a disk image (sparsebundle) encrypted. Tri-BACKUP copies the data to the disk image (after it mounted
automatically) and another machines retrieves the data transferred by the service.

Note: a sparsebundle disk image is composed of a set of small files and only the modified pieces are transferred, thus reducing the transfer. The use of a standard disk image (one big
file) would transfer all of the disk image for each change.
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Which action to choose?

For all operations (copy, backup etc..), you must create or open an action, then define the settings and launch it (or set the automatic trigger).
Tri-BACKUP offers "Programmed Actions" and "immediate Actions".

The "Programmed Actions" are designed to keep the settings (to avoid having to repeat setup each time) and run automatically (although they can also be launched manually
by the user).

The "Immediate Actions" were created to visualize and compare the contents of folders or disks, if you wish to check the content, or to choose specific files or folders to copy
or treated.
Note: There are immediate actions that correspond to each of the programmed actions.

How to choose a type of action?
Depending on your needs, you choose the type of action that best suits them. Needs can be diverse, Tri-BACKUP has different actions.

You will find below an explanation corresponding to the main needs.

Copies and backups

You wish to copy your boot disk
The goal is to have an identical copy of your primary disk directly usable. We can then restart from the copy if necessary, or if the primary disk has a problem.
Use the programmed action "Bootable Copy": The copy will contain the system, your applications, documents and settings (an exact copy of your environment).

If you wish to make a punctual copy, disable the auto-execute settings. Once the action is created, you launch it manually in the panel "Programmed Actions," with the button
"Execute Now".

If you want the copy to be automatically and regularly updated to keep it the same as your main drive, program it to run periodically (eg daily).

Note: The first execution will be long (since everything will be copied). Subsequent runs will be much faster because only a portion of the data will need to be updated.

You want to create a bootable rescue disk
The goal is to have a disk with a minimal system where restart in case of need, for example to repair the main disk.

Use the programmed action "Bootable Copy", with the option to create a minimal System (in the Options panel).

You want to make a backup of the contents of a folder

The goal is to have a copy of certain documents.
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Use the programmed action "Copy Folder": The copy will contain an exact copy of the original. Each execution of the action will update the copy, adding new files and
replacing the modified files.

Note: If you want to do this operation one time only, you can use an immediate action "Copy".

You want to make a backup of several separate files
The goal is to have a single backup for several folders.

Use the programmed action "Mirror Backup" that allows you to save multiple folders or disks. The copy will contain a folder for each source folder / disk, each of these folders
containing the exact copy of the related original.

Each execution of the action will update the copy, adding new files and replacing the modified files.

You wish a backup that keeps previous versions of each document

The goal is to have a backup of your data with the latest version, while retaining the successive versions of files (when only the latest version is kept with the copy or mirror
backup actions).

Use the programmed action "Evolutive Backup": The copy will contain a folder for each source folder / disk, each of these folders containing the exact copy of the related
original. Each folder also contains a specific hidden folder where the the old versions of changed or deleted files are kept.

Each execution of the action will update the copy, adding new files and replacing the modified files (the old version is moved to the specific folder).

You want to make a new separate backup for each execution
The goal is to have, for each new backup, a new copy of your data in a new folder.
Use the programmed action "Incremental Backup™: The copy will contain a folder for each source folder / disk, each folder containing the copy of the related original.

You can choose to copy, for each execution, only the recent files (old files are not copied to the backup), or all files from the source (the copy is complete and all files will be
copied each time, including those who had not been modified since the last backup).

You wish to backup to an FTP server
The goal is to have a backup of your data to an FTP server (eg internet).

Use the programmed action "Copy to FTP Server" which allows you to save multiple folders or disks. The copy will contain a folder for each source folder / disk, each of these
folders contains the exact copy of the related original.

Each execution of the action will update the copy, adding new files and replacing the modified files.
Note: This action is similar to the 'Mirror Backup”.
Note: You can use an immediate action to review and select items to copy.

You want to make a local copy of an FTP server

The goal is to have a copy of the data from an FTP server on a local disk.
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Use the programmed action "Copy from FTP Server": The copy will contain an exact copy of the original. Each execution of the action will update the copy, adding new files
and replacing the modified files.

Note: This action is similar to the action "Copy Folder".
Note: You can use an immediate action to review and select items to copy.

You want to compare the contents of two folders

Use Immediate Action "Compare": The list shows the different items. Select files or folders and click the Compare button and the action will compare the contents of each file.
The results are displayed in a list.

You want to synchronize two disks physically distant
The objective is to synchronize two large disks that are not physically accessible simultaneously by using a third portable disk (which does not need to be as big as the two
disks) that you can move from one disk to the other.

Use the actions "Create MagicProfile" and "Sync with MagicProfile". You first create (with the action "Create MagicProfile") a "snapshot” (profile) of the contents of one disk
(profile created on the portable disk). Then you compare this profile with the contents of the other disk with the action "Synchro with MagicProfile" and only the differences
will be copied to the portable disk to be copied in turn on the first disk.

Note: The actions "Create MagicProfile" and "Sync with MagicProfile" also exist as immediate action.
Synchronization

You wish to synchronize the contents of two folders
The objective is to perform the update of two folders by copying the missing documents and the latest documents in the other folder.

Use the programmed action "Synchronize two Folders™ The contents of the two folders will be strictly identical after synchronization. Each execution of the action will update
the two folders, adding new files and replacing older files with the latest version.

Note: If you want to do this operation from time to time, you can use an immediate action "Synchronize"
Synchronization modes: You can use two modes of synchronization:

- The direct synchronization (Synchonize by comparing the contents of each folder) compares the contents of folders and replace the old files with new ones, and copy the
missing files. The options provide different behavior for the missing items.

- Synchronization of changes (Synchronize by comparing the changes since the last synchronization) compares the current contents of each folder with the previous
contents to detect what has changed. Items that have been modified, added or deleted on one side since the last synchronization will be copied (or deleted) on the other side.

Note: To synchronize with change detection, Tri-BACKUP saves (after each synchronization), in each folder, the list of items in this folder in a special reference file (and invisible)
named ".tbu_foldercontents_forsynchro.data". During the first synchronization (or if the reference file does not exist), a direct synchronization is performed.
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You want to synchronize two disks physically distant

Use the actions "Create MagicProfile" and "Sync with MagicProfile" (see previous page).
Other Actions

You want to compare two states of the same disk

The objective is to compare the contents of a disk with its content as it appeared at a previous date (eg before / after installing an application).
Use the action "Create MagicProfile" to create a "snapshot” (profile) of the initial content of the disk. This creates an identical copy (as would the action "Copy Folder") but the
copied files are empty and the copy obtained has a very small size (it can be saved to a disk image for reference ).

Then use the "Analyze" option in the immediate action "Sync with MagicProfile" to list the differences.

Note: You can also use the action "Compare" by comparing the date of the files (the sizes are of course different).

You want to regularly empty the contents of a folder
The aim is to regularly clean specific folders (temporary work folders, caches, etc.).
Use the programmed action "Delete Folder": With each execution, the contents of the folder will be deleted (note that the removal cannot be cancelled). The folder itself is not
deleted.

You want to compress (and encrypt) the contents of a folder
The goal is to convert each file in a folder to a compressed file (and possibly encrypted with password).
Use the programmed action "Compress Folder": For each execution, each uncompressed file will be replaced by a compressed version.

Note: The compression format is a proprietary format of Tri-BACKUP. Tri-BACKUP is necessary to decompress and restore the original file.

Note: If you want to compress a copy (not the original), use the action "Copy Folder" and select the compression in the options.

You want to uncompress (and decrypt) the contents of a folder
The goal is to revert each compressed file in a folder to the original document.

Use the programmed action "Uncompress Folder": For each execution, each compressed file will be replaced with the original uncompressed version.

You want to change the visibility or change the owner of the items in a folder
The goal is to edit each file and each folder.
Use immediate action "Modify Folder".

You want to display the size of the contents of a folder

The objective is to quickly visualize the size occupied by each subfolder of a folder.
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Use immediate action "Calculate Size of Contents".

You want to compare the size of the contents of two folders

The objective is to check whether there are differences in size of the contents of two folders.

Use immediate action "Compare Folders Size".

You want to compare the contents of two folders

The objective is to detect the differences in two folders.
Use immediate action "Compare Folders Contents".
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Tri-BACKUP 8 - The main application

It is from this application that you create and manage your actions. It is also in this application that you have the reports and tools available to you by Tri-BACKUP 8.

The main window

The main window contains the buttons on the top for creating and managing actions, and buttons on the left for different tools. Clicking a button displays the corresponding
panel in the center:
Welcome: To start and quickly create your first programmed actions.

Create Action: This panel allows you to create the programmed actions.

Programmed Actions: This panel lists all the programmed actions that you have created. You can edit and run manually.
Immediate Actions: In this panel, you can open an immediate action or re-use of the latest actions.

Restoration: This panel allows you to restore data that had been saved by Tri-BACKUP.

Latest actions: Results of the last programmed actions executed.

Tools: Offers various tools and reports.

Volumes: Displays information about the currently mounted disks.

Check status: Panel to check the general state of Tri-BACKUP (useful for sending a report to the technical support).
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Welcome

For your convenience, you can easily create from this panel two basic actions (the first ones that anyone should create): a programmed action to make a copy of your internal
drive and another action to save your "home" directory (your user folder).

@ &R Tri-BACKUP Pro 8

o (Y o

= - S .

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

“:I Where to start?

You can start by creating your first actions to copy your startup disk and backup your most important data to another disk

Easlnchons (for better security).

X — | \ Create a bootable copy of your startup disk... Create...
s Lo This programmed action will copy your startup disk to another disk. The action can be executed regularly to update the
Tools copy. If necessary, you can restart from the copy or use it to restore or replace your internal drive.
A __ Backup your Home folder... Create...
Volume % This programmed action will copy your user data ("Home"): documents, photos, music, videos, emails, settings, etc. The
e action may be executed regularly to update the copy of your data.
v And then?
Check stat q . .
neckstatus Now that your data is secure, you can create as and when you need them other actions to copy, backup, synchronize and

archive your data.
Take some time to discover all that Tri-BACKUP can do for you!

(7] Open Users Guide...
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Create Action

This panel displays the different types of programmed actions available. By clicking the top selector, you can view all types (All Actions) of action in the list or certain types
(Basic Actions, Backups, FTP Backups, etc.). Other Actions list the types that are not in the previous categories (but these actions are also displayed in the All Actions
selection).

When you select a type of action, its description is displayed to the right.

® &R Tri-BACKUP Pro 8

NS Q@ O

) T > > -«

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration
]D All Actions Basic Actions Backups FTP Backups Other Actions
All Actions :
Last actions _ + Create Action...

E Bootable Copy Bootable Copy

Create a bootable copy of a startup disk

X

Use this action to create a bootable copy of

i Copy Folder your startup disk. This copy can, for example,
Tools Copy the contents of a folder be used to continue working immediately with
the same environment in case of problems on
Synchronize Two Folders your disk (copy updated regularly), to
. Synchronize the contents of two folders duplicate a boot disk with its environment on
multiple machines, or to create a reference
AT !) Display Alert copy of a new System.
4 Display an alert, launch a file, etc. Warning! You can not choose the current
startup disk as the destination, because the
J « \ Mirror Backup system will not accept that modifications on
T2 Backup a set of folders or disks items in use. Start from another disk to restore
Check status your startup disk.

= Evolutive Backup

The bootable copy will be done in a hard disk,
®w Backup and keeps multiple versions of each file

either internal or external. The copy will contain an

To create an action, double-click a type of action in the list (or use the Create Action... button).

A simple editor for the type of action you choose is displayed. It allows you to set the name you want to give this action, the basic settings of the action (depending on the type
of action) and basic settings for the automatic execution.
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Welcome

0

Last actions

P8

Tools

Volumes

v

Check status

Q O

= = <=
Create Programmed Action Programmed Actions Immediate Actions Restoration

Title: | New action (Bootable Copy) L » \ ootable
—
Source Disk: Destination Disk:
(=] MBP15 HD & - SSD MBP15 HD S
192 GB used (48%) on 400 GB Actually 173 GB used on 399 GB

Ma X 10.11 After copy 192 GB will be used (48%)
This; d}..(;kiciaa boota Ma'(‘:' (Ilr;iél). Valid f(;r arlt;o;J{arl;\ér copy [G.L; Dfor Intel)
Keep the folders already in the root of the destination disk (and absent from the source disk)
B tain extra data
The destination disk is large enough to copy the entire disk.

You can create a bootable copy on the destination disk
CAUTION! The extra data in the destination will be deleted with the default settings.

(7] What will be done by this action?
[ ) Automatic Execution: None =
< Cancel o Check with an Immediate Action +  Create...

Click the Cancel button to return to the list of types of actions without creating the action.

When your settings are done, click the Create... button. The settings are saved and this new action is added to the list of actions (accessible by the panel "Programmed
Actions") where it can be edited or launched later.

Dialogue offers you to edit the action or launch it immediately.

Note: The simplified editor only offers the basic settings of each type of action. Other settings and filters are available in the editor of programmed actions. Open the "Programmed

Actions" and double-click an action to edit it.

What will be done by this action? displays a brief description.

Check with an immediate action will open an immediate action with the settings defined for this action. You can directly check the effect of your settings.
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Programmed Actions

You will find in this panel a list of all the programmed actions that you have created. The list can be displayed with or without groups, filtered and sorted.

® % Tri-BACKUP Pro 8
C]
" © NGO o
A > J = <
Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration
D + v E = All Actions % Q Sort by Name &
1 ‘ Actions: 59 All Actions (No specific parameters) < All Actions (All Sources and Destinations) o
Last actions > Clone Disgues > Backups X4
2 Actions
) = Copie Disques > HD Bureau
X 2 Actions
v Copie Disques > HD Portable
Tools 2 Actions
a Sider] (e ; Last: Yesterday at 13:07
> Copy Data > TR Data Copy y | («Admin) [0} Next: Today ot 12:50
F f TR to “TR Data Copy 104
. 4% Copy MBP15 HD > TR System y1 (+Admin) [ o R

TRS

Volumes o
v Copie Disques > SSD Externe
2 Actions
w En H Last: Yestercay at 15:27
v o Copy Data > HD2 (SSD) (Copy Folcer] (+Admin) W o w1240
Check status e 3 COPV MBP15»H[‘J > HDZ (SSD) Bootable Cof (+Admin) [} ;aﬁgxze1§é%r:yagta‘t|21:§:g7

+V

Add: The popup menu on top left of the list lets you create an action or a group.
Groups: You can create groups to organize actions as needed. You move action in a group by drag / drop. The actions can be displayed in a single list or hierarchical groups.

Filter: You can filter the list to display only certain types and context, and use a text search on the title and source and destination items (to show only the actions of a particular
disk, for example) .

Edit: You can duplicate an action, edit it to change settings or delete it. Edit the action to have full access to all the options of automatic execution.
Action execution

You can manually launch a programmed action at any time, either if the automatic execution of the action is enabled or disabled. Select the action (or the group) and click the
Execute Now button.
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Preview with an immediate action (with the settings of the selected action)
Click on the Preview... button to open an immediate action with the settings of the selected programmed action. You can use this function to check the result of an action

after his execution, check the settings or make a minor update manually.

Other operations

Use the popup menu ’ LM to edit, duplicate and delete the selected action. You can also:
Estimate the size...: This function will start executing the selected action to calculate the size of which would be copied, replaced, or removed by a normal execution (but

this execution does not copy or change anything).
Create a restore action...: This option creates a programmed action with settings corresponding to the selected action (for example, if an action copy folder A to folder B,

the restoring action will be set to copy the folder B to folder A) .
Show last executions: Displays the history of past executions of the selected action, with the files copied or modified and any errors that occurred during the execution.

Show the summary of the action settings: Displays the settings of the action in the form of text.

Activate/Deactivate
Buttons ON and OFF on bottom right let you enable or disable the automatic execution of selected actions. If you select a group, the execution of all actions of this group will

be changed.
Note: The automatic execution of programmed actions can be associated with a context (home, office, nomad). You can choose certain actions to be executed only in the current

context (for example, that certain actions execute at the office and not when your computer is at home).

Graph of last executions
The button at the bottom right displays a quick view of the recent executions of the selected action with the execution time and the amount of data copied.

Execute Now Preview...

i Last executions of "Copy MBP15 HD > X4-2" [
20 executions Execution time (min: 0:20 - max: 31:59) . Size [ total (%)
. 3févr..

20 jenv... 21 janv... 22 janv... 22 janv... 23 janv... 23 janv.. 24 janv... 24 janv.. 25 janv... 25 janv.. 26 janv.. 27 janv... 28 janv.. 29 janv... 29 janv.. 30 janv... 31 janv.. 1 févr... 2 févr...
0:20 25:27  29:48 5:29 28:08 25:49 5:22 26:36 0:22 27:52

31350 | 30:52  20:13 24:43 6119  27:16 517  20:28 616  26:20

2.4% 9.6% 5.8% 0.33% 1.3% 4.1% 0.88% 20%  4.4% 2.6%  2.8% 2.2% 6%
| A X X X X X x X
II.- B o B s -m -0 o B B . -

The blue-grey bars indicate the execution time and the red bars the percentage of copied data.
The warning sign (yellow triangle icon) indicates that there were one or more errors during the execution of the action. Finally, the red cross indicates that the action could not be

performed (disk not mounted, etc.).
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Execution of actions by a keyboard shortcut

You can manually launch a programmed action at any time through a keyboard shortcut that will open a launch window (Tri-BACKUP 8 does not need to be launched).

You set the keyboard shortcut in the preferences of Tri-BACKUP 8 Scheduler. For example, if you set the keys "Ctrl + right arrow" as a shortcut, you press both keys

simultaneously (at any time and from any application) to make the launch window appear, where you can choose the action to launch in the list (possibly after filtering by
name or quick code assigned to an action or a group).

Note: You can assign a quick code for each action or group to find and launch it quickly.

Example: You have assigned the code "bk3" to a group containing three actions. Type the shortcut to bring up the launch window, then enter "bk3" in the search field and hit "Enter"
to launch these three actions.

Tri-BACKUP 8 - Users Guide 30/77



Immediate Actions

Buttons allow you to create a new immediate action for the most common types. The Other popup menu allows the creation of immediate actions of any available type.

@ &R Tri-BACKUP Pro 8

() 0

) -> > T -

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

Create new immediate action:

]D L~ i ", -t QO others ~

Last actions

Copy Synchronize Copy to FTP Compare
x Actions: 14 Actions of All Types = Q
Tools Recent immediate actions (double-click to edit and use again)
Action Source Destination Date

. # Modify Folder Contents Photos en attente (in 7r Data) 01/01/2016 14:55
4 % Uncompress Folder Contents Téléchargem...(in MBP15 HD) 17/12/2015 09:20
Volumes @ Delete Folder/Disk Contents TR Data 15/12/2015 15:57
%2 Compare Folders Contents TR Data SSD TR Data 15/12/2015 15:28
= Copy Folder 1-1 (in MBP15 HD) 1-1 - copie (in MEF15 HD) 15/12/2015 15:04
J =) Copy Folder 1-1 - copie (in MBP15 HD) 1-1 (in MBP15 HD) 15/12/2015 15:04
Check status 2. Compare Folders Contents  1-1 (in M8P15 HD) 1-1 - copie (in MBP15 HD) 15/12/2015 14:55
=) Copy Folder Tri-BACKUP 7 (in m8P15 HD)  Tri-BACKUP 8 (in M8P15 HD) 14/12/2015 16:05
%2 Compare Folders Contents  Tri-BACKUP 7 (in M8p15 HD)  Tri-BACKUP 8 (in M8P15 HD) 14/12/2015 15:56
2 . Compare Folders Contents  1-1 (in MEP15 HD) dest (in MBP15 HDI 14/12/2015 15:03

This panel lists the last immediate actions, ordered from most recent to oldest.

You can filter the actions displayed by type and with a search on the name of the action, the source or destination.

Use again one of the actions in the list
Double-click an action to use it again (with existing settings).

A window opens for each specific type of immediate action (see "Immediate Actions" chapter in this manual).
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Restoration

This panel displays the options for restoration.

()

& Tri-BACKUP Pro 8

i 0
>

5>

o
= J

Welcome Create Programmed Action

N T

Last actions

b

Tools "'* \
X
——

Volumes

<=

v

Check status

Programmed Actions

Restore from Recent Backups
Search recent actions that have backed up a particular folder

Restore Folder
Restore the contents of a folder

Restore Bootable Disk
Restore a disk from a bootable copy

Restore Evolutive Backup
Restore the contents of a folder from an Evelutive Backup

Restore Time Machine backups
Restore the contents of a folder from a Time Machine backup

Immediate Actions

Restoration

+ Create Restore Action...

Restore Disk/Folder
from a recent backup

Use this action to restore the contents of a
disk or a folder from a backup.

This action begins by asking what is the folder
or disk to restore and search actions that have
saved that folder (or disk). You can then
choose from which backup you want to
restore.

Al different file will be replaced by the one from
the backup. Identical files are ignored.

With the options, you can delete items that are not
in the backup, use filters to exclude items, etc.

This action does not modify the contents of the
backup folder.

This action modifies the contents of the restored
folder.

By the principle used by Tri-BACKUP for its backups (i.e. copying files to the same preserving the folder hierarchy), you have multiple ways to recover data backed up: manual
recovery from the Finder, use of an immediate or programmed actions and use of specific recovery features.

The various restoration actions offer the options and exclusion filters to restore exactly what you need. The restoration can be done automatically (with a
programmed action) or manually using an immediate action.

Note: A restoration can be done with any immediate and programmed action to copy the data from the backup to the original location (or any other location).

Restore from Recent Backups

To restore a particular folder, this function shows you the programmed actions that have saved it and where the data were saved. The list first displays the last actions having
saved this data. You can easily find the backup you want and restore from this backup.

The Cancel button returns to the Restoration panel.
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You can open an immediate action to visually verify what has been changed and retrieve what you are interested. Alternatively, you can create a programmed action for the
restoration.

® &2 Tri-BACKUP Pro 8
" 4+ Q@ O AN
(3] = = => J =
Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration
Q Restore from a recent backup...
1D‘ Restore the contents of:
Last actions Choose the folder you want to
restore. Tri-BACKUP will ) _ Documents v
» search actions that have - & (click to get the size
X backed up this folder. e ™ | MBP15 HD/Utilisateurs/thierry
Tools This volume is HFS formated

Volumes | P8 Copy MBP15 HD > X4-2 [Copy Folder] (+Admin) T IR
Copy contents of “MBP15 HD" to "MBP15 HD (X4-2 Backups) 402 executions
- F t 5 «Admi Last: Yesterday at 15:17
v #| Copy MBP15 HD > HD2 (SSD) (8cotable Copy] (Admin) ] 3 Yesterday at 120
- Raot a Con «Admi Last: Yesterday at 12:45
Check status =2 FODY MB,F?‘.l 5H[{ >’TR,SY§te'r;]S~-:!-3r“ Pyl eAdmin) " —r Toaqy TR
—u1 Copv MBP15 HD > HD Svstem [Eootable Copyl (sAdmin) @ | Lasu Yesterdayat08:23

< Cancel Open Immediate Action... Create Restore Action...

Restore Folder

This function is similar to the programmed action "Copy Folder", but some options have been activated for the Restoration: uncompress compressed files and the ability to
overwrite files with the saved version, even if it is older.

Note: You can change the basic settings to suit your needs.
Restore Bootable Disk

This feature allows you to restore a System disk. It is quite similar to the programmed action "Bootable Copy", but some options have been activated for the Restoration:
uncompress compressed files and the ability to overwrite files with the saved version, even if it is older.

Note: You can change the basic settings to suit your needs.

Restore Evolutive Backup

This feature allows you to restore a folder that was saved with a programmed Evolutive Backup action, choosing the date of the backup to restore.
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The actions having saved the folder are displayed in the list, where you can choose the one you want. The popup menu displays the dates of available backups.

You can open an immediate action to visually verify what has been changed and retrieve what you are interested. Alternatively, you can create a programmed action for

restoration.

()

Welcome
Last actions
X

Tools

Volumes

v

Check status

&2 Tri-BACKUP Pro 8

(4 () o

= > >

Create Programmed Action Programmed Actions Immediate Actions Restoration

42

Restore from an Evolutive Backup...

Restore the contents of:

Choose the folder you want to
restore. Tri-BACKUP will —

search actions that have O (click t
backed up this folder.

Source Evolutif v

TR Data/Tests Tri-BACKUP 6
This volume is HFS formated

Drag and drop a folder or a disk, or v

Last: Today at 11:04
Automatic execution disabled
2 executions

Evolutive Backup 1 [Evolutive Backup]

“* Evolutive Backup of “Source Evolutif (TR Data)" to “Destination Evolutif (TR Data)*

Restore from the backup made on 03/02/2016 11:04

< Cancel Open Immediate Action... Create Restore Action...

Restore Time Machine backups
If the Time Machine disk is mounted, Tri-BACKUP is able to go digging through the data looking for all backups of a particular folder.

This feature allows you to restore a folder that was backed up by Time Machine, choosing the date of the backup to restore. You specify the folder to be restored and Tri-BACKUP
search and proposes all Time Machine backups of this data, with selection of the date to restore.

<>
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[ &R Tri-BACKUP Pro 8

(+) Q) o A

A - > - T
Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration
" I E\ Restore from a Time Machine backup...
D —
] J Restore the contents of:
Last actions Choose the folder you want to

restore. Tri-BACKUP will Documents v

search backups for that folder

X DR ML EEANEEE S MBP15 HDJUtilisateurs/thierry
Tools This volume is HFS formated
Drag and drop a folder or a disk, or - v
. Time Machine backup:
Volumes o) i the folder to be restored, Tri-BACKUP will search if there are backups for that
- me Machine disks.
/ . On 09/04/2015 at 00:02 Select a Time Machine backup: Today at 10:44
HD Time
Check status Machine L__*
On 15/01/2016 at 00:30
< Cancel Open Immediate Action... Create Restore Action...
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Last actions

This panel displays the list of the last executed programmed actions (the most recent being at the bottom).

For each action, are displayed time, date and duration of execution and results summaries (number of files, errors, stats, etc.) .
Select an action to display with the tabs a list of the files copied or treated as well as the list of errors . Each line displays the name and path. An icon indicates the type of
operation (see the meanings in the Help menu).

Note: Only 5000 last items are preserved for history of each action, and only the latest histories (olders are deleted).

You can also view statistics for the execution of the action (progress during execution time with quantity copied and analyzed).

® &2 Tri-BACKUP Pro 8
(4} O
A\
() = = = <=
Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration
£ '\E ¢ All Actions 2 Q Show All 2
J\ ) Source/Destination filter All Actions (All Sources and Destinations) T
Last actions When A Duration Action
Yesterday =2 Nothing modified
, 16:37 9:56 23 Copy MBP15 HD > HD2 (SSD) (Action completed)
X Yesterday == 1996 589 [3 347/sec.] (188 GB). Copled: 12 630 (3.4 GB). Replaced: 8 682 (2.7 GB). Deleted: 1 424 (447 MB).

Tools 16:47 0:29 > Copy Data > HD2 (SSD) (Action con d
Yesterday 195 692 [6 662/sec.] (395 GB). Copied: 199 (94 MB). Replaced: 75 (52 MB). Deleted: 14 (3.0 MB).
16:59 1:46:09 g Copy Data > Archives (Action comple
Yesterday %= 195 692 [30/sec.] (395 GB). Copied: 190 262 (392 GB).
. A0:.00 1:70:14 Canme MEDAE UN s Archiuae (Anting mnolotod
Files Errors m Report
Volumes : P L-"
Scan (files/second) Copied/Scanned « Scan progress (0-100%) Copy (size/second)
J — — . . 24 MB/s
—— ¥
Check status . TT:.__—I—;‘ — 1
0:03 0:04 0:05 0:06 0:07 0:08 0:09 (mn)
Error codes... Other results...

The Report panel shows information about the execution of the action.
Other results... button at the bottom right can display histories from older actions or other machines by directly selecting the file where the data is stored .

The default folder is the "History" folder, but you can go in old backups or on other machines to select contents of this folder.
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Tools

This panel gives quick access to various tools provided by Tri-BACKUP.

Edit Common Filters
Programmed actions and immediate actions have filters to exclude certain files or folders, or otherwise treat only certain files or folders.

Each action has its own filters, but you can also create sets of filters that you can use in several actions (eg if you need identical filters for these actions).

Clean Evolutive Data
Actions "Evolutive Backup" keep the extra data (old versions, etc.) in specific folders that are invisible by default.

With this tool, you can make these folders visible or remove some of this data to free space on the backup disk.

Global Disk Change

When you define a source or destination folder in a programmed action, Tri-BACKUP records information on the disks containing these folders to detect it if necessary. In
addition to the disk name, Tri-BACKUP saves the size and creation date of the disk, to distinguish, for example, two different drives having the same name.

If you change or reformat an internal or backup disk, you must redefine each action to set the new disk.

This tool allows you to globally change the references to a disk for all the actions that use it, which greatly simplifies the change.

Other Tools

Some other tools are available in the Tools menu.

Access the Settings folder...
This menu displays the folder in the Finder where are saved all settings and reports of Tri-BACKUP. This folder is located in the /Library/Application Support/ folder of the user.
The /Library/ folder is hidden by the System and the menu gives you easy access to it.

Copy the settings of Tri-BACKUP on mounted volumes...
This menu automatically creates copies of the contents of the Settings folder (list of programmed actions, reports, settings). The copy can be used when needed (loss or erasing
of the disk, change of computer) to find settings and logs. It is possible to program copies on multiple disks to increase security.

Export a list of the contents of a disk/folder...

Tri-BACKUP can create a list of content and save it in a file. You can keep the files of various contents for later analysis or comparison or to easily send the list (for technical
support or otherwise).

Note: The resulting file contains only the names of files and folders (no data from the files is added).
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Open a list of contents...

This function is to read the list of previously saved content to view, navigate and search the folder structure or the recorded contents.

Show Information about Connected Disks
Display information for each of the disks and volumes connected to your Mac, whether mounted or not, including system partitions.

You can select an item for more detailed information.

[¢] [ ] Connected Disks
(]

Disk / Partition Size Name Format
#3 disk0s3 650 MB Apple_Boot
#4 diskOs4 600 GB Apple_CoreStorage
#5 disk0s5 134 MB < Apple_Boot

disk1 400GB ™ MBP15H Apple_HFS
Content = Apple HFS

DeviceIdentifier = diskl
MountPoint = /

Size = 399664451584 (399.66 GB)
VolumeName = MBP15 ED

Additional information on the volume:

Duplicate Partitions Map...

See the chapter for this tool later in this manual.

Copy Hidden Partition Contents...

See the chapter for this tool later in this manual.

Create Recovery HD Partition...
See the chapter for this tool later in this manual.
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Volumes

This tool displays mounted volumes and shows different information on each disk: size, format, useable as a boot disk, OS X version (if any), etc.

(] &R Tri-BACKUP Pro 8

4+ Q o
-

) > > -

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

Mounted volumes:

]D o Size fills column Logs

Display used and free space as %

Last actions Volume Used / Size | Free Format Connection
B MBP15 HD (05x 10.11.3 HFS / GUID
X Information about the selected volume:
Tools 0OSX 10.11.3 - GUID partition: This volume can be used for a boot disk on Mac Intel (not PPC) o
Created: 05/10/2013 17:45:04 UUID: 6E233B57-3CDA-32B5-B13B-6B130B3FE524
Modif 03/02/2016 13:19:40 399 664 451 584 (399.66 GB)
L/ 1972554 Device: disk1 Mount: [
J ! D Mac OS Extended (Journaled), Encrypted, SSD, Internal
Volumes 29 Programmed Actions use this volume a a Check Disk Speed...
Evolution of the space used on the selected volume:
J Used Size a Evolution for: 30 days a
Check status 03/02/2016 08:00 | 191.18 GB (48%) 90%

03/02/2016 09:00  191.95 GB (48%)
03/02/2016 10:00  192.78 GB (48%)
03/02/2016 11:00  192.98 GB (48%) e . o
03/02/2016 12:00  195.88 GB (49%)
03/02/2016 13:00  195.74 GB (49%)
03/02/2016 13:19  195.66 GB (49%) 5§ 6 7 8 9 1011121314 151617 18 19 20 21 22 23 24 25 26 27 28 29 30 31 1

More information: Click the @ button to get extended informations on the selected volume. These are information reported by the System.

Programmed actions using this volume: A popup menu list the programmed actions that use the selected disk (or one of its folders) as source or destination.

29 Programmed Actions use this volume '
' Copy MBP15 HD > TR System - [Source] - Today at 12:46
. Copy MBP15 HD > HD2 (SSD) - [Source] - Today at 12:35
= Copy MBP15 HD > X4-2 - [Source] - Today at 08:15

Ey
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Check disk speed: You can make a summary measure of disk access speed. This tool gives an indication and does not claim to replace specialized tools.

807 MB/s
a Check Disk Speed...

Volumes Free Space: Tri-BACKUP records regularly occupied space on the mounted disks. With this tool, you can view the evolution of the occupation of your disks. You can
then decide when it will be time to change a disk to a bigger one, or clean a disk to make free space.
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Check status

This panel gives you an overview of the general state of Tri-BACKUP and its associated processes. You can use it to check the status of the application and if all is correctly
installed and working.
You can copy the summary text and send it to our technical support when needed (it will help us see the context if you have a problem).

@ & Tri-BACKUP Pro 8

) (Y o

) > = N «

Welcome Create Programmed Action Programmed Actions Immediate Actions Restoration

(=]

Last actions

Installation of Tri-BACKUP 8

Tri-BACKUP is correctly installed.

<«

X Automatic execution of programmed actions <
X The Scheduler is correctly set to automatically execute programmed actions.
Tools
Results of the programmed actions executed Last 15 days o
. Some actions have reported fairly frequent errors or interruptions (in at least 30% of their executions during the specified
e period). See details below.
Volumes
/ Contents of /Volumes/ folder Show...
‘ The content of the /Volumes/ folder is correct.
NantV 4
Check status State of Tri-BACKUP 8

* Tri-BACKUP is correctly installed.
+ The Scheduler is correctly set to automatically execute programmed actions.

~ Cama natinnn havin sanartad fnivh framinnt amass arintaveintinna fin ot lanat 200/ _nf thaic ava
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Preferences

In the menu Tri-BACKUP 8, you access the Preferences settings.

Preferences are grouped into several panels for settings of a general nature (checking updates and date format), the executions of the programmed actions (basic and display
settings and a button to access all the execution preferences of the Scheduler) and daily reports that can be sent to an administrator or to yourself to have a follow-up of
backups and other copies and operations made by Tri-BACKUP.

Executions  Reports General m Reports General  Executions

Tri-BACKUP Scheduler Process Daily Reports
Tri-BACKUP Scheduler is the process which automatically launches the Send Daily Reports by Email
Check for new versions programmed actions.
User Reference: ‘miew
Launch Tri-BACKUP Scheduler at startup
Date and Time Format Note: To execute the actions, Tri-BACKUP Scheduler must be launched. Send an email to: | administrator@company.com
Check the *Launch at startup” option to have the actions automatically Address of sender (your |, : §
5 thier mail.com
Choose a format... B Code: | en US executed. e ry@gmai
1/28/16, 4:12 PM January 29, 2016 at 4:12:29 PM When an action is executed SMTP server: | smtp.gmail.com

Display the mini floating progress window SMTP Port: | 465 Default Ports...

Display the main progress window Newline format: | Automatic

Icon in the menu bar Authentication: | Password
@ Always visible B Use TLS (SSL)
SMTP Login: | thierry@gmail.com
Password:  seescccscecscessccne
Save As Default Use Default
?

Open Execution Preferences... Test
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Actions Menu

In this menu, you can activate, duplicate, import, export the programmed actions, create immediate actions, etc.

GoTo Menu

This menu displays the mounted volumes and allows to navigate in their content (including in invisible folders).

Tools Menu

Allows you to access the folder containing Tri-BACKUP settings and automatically make copies of your Tri-BACKUP settings.
You can also create a list of the contents of a folder and export it (in order to reuse it later or to transmit it for support or other).

You can also in this menu stop and uninstall Tri-BACKUP.

Window Menu

Other features are available in the Window menu of Tri-BACKUP.

Show Logs and Messages
During operation, Tri-BACKUP and associated processes record various information about their activity.

This tool displays a window that lists the latest logs.

Show Daily Reports
Displays activity reports day by day.
Note: These reports can be automatically sent daily by email to the recipient of your choice (you specify in the Preferences).
Show Mac and Tri-BACKUP activity...

This window shows the periods of use, stop and sleep of your computer and Tri-BACKUP. For example you can check if the execution of an action was interrupted by a sleep of
your computer.

Tri-BACKUP 8 - Users Guide 43 /77



Mac Activity (Tri-BACKUP)

. Note: The activity is recorded only when the Scheduler is running
Activity of the Mac suspended
Execution of a programmed action G -+ < >
B Tri-BACKUP opened (main application)
24 janv. 2016 | 25 janv. 2016 | 26 janv. 2016 | 27 janv. 2016 | 28 janv. 2016
10:46 08:28 17:13
10:26 16:22 10:06 16:54 10‘:.15
Nmiom 1 I Inl () (Il | mInil i
m 1 [anndinnrnannnnnnnna]
6:00 12:00 18:00 0:00 6:00 12:00 18:00 0:00 600 12:00 18:00 0:00 600 12:00 18:00 0:00 6:00 12:00 18:00
24 janvier 2016

10:26 - Activity suspended after 10:26 (h:mn)

10:46 - Activity resumed after a suspension of 0:20 (h:mn)

| Show Power Management commands (System)

Buttons at the top right allow you to display the period that interests you, by displaying more or less days and earlier period.

Show CrashLogs...

This window displays the diagnostic reports for Tri-BACKUP applications and process (you can also access it via the Console).
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Edition of the Programmed Actions

To edit a programmed action, select the panel "Programmed Actions" and double-click the action.

[ NON ) Copy MBP15 HD > HD2 (SSD) (Bootable Copy Editor)
E, Action © Trigger ¥ Options K Filters Before/After
Action Type: L3 Bootable Copy 2 Color: @ Orange ¢
Action Title:  Copy MBP15 HD > HD2 (SSD) Quick Code:
Comments:
Copy the contents of: To:
& MBP15 HD S — SSD MBP15 HD S
189 GB used (47%) on 400 GB Actually 171 GB used on 399 GB
System Mac OS X 10.11.3 [ After copy 189 GB will be used (47%)

Format: GUID partition (Intel Mac) Format: GUID partition (Intel Mac)

This disk can boot a Mac (Intel). Valid for a bootable copy (GUID for Intel)

Destination distributed over several volumes?
Volumes detection mode:

Strict detection (check the volume name, UUID, size and creation date, and if the path exists) ?
° Accept any volume with the same name (if the path exists)

[} Preview... Summary... Cancel Save

Settings of Programmed Actions (and Immediate Actions) are edited in a window. One window is opened for each action that is edited.

Panels
The edit window has always the same organization in different panels, accessed by clicking the top bar.

Action: To set the type of action, the title you want for this action (for easy retrieval in the list) and the basic settings (source and destination, for example).
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Trigger: This panel allows you to define the conditions of automatic triggering of the action (at a specified time or after specific events, such as mounting a disk - to execute

a backup on this disk - or when you leave an application - to copy or backup data modified by this application, for example). You can set multiple trigger conditions (eg
every week, and also if you connect the backup disk).

Options: This panel is specific to each type of action. You will find options for copying, using compression, permission to delete files, etc..

Filters: Filters are used to exclude certain items (eg not to copy temporary data and unnecessary files) to lighten the copy or treatment, or not to modify certain files or
folders. A button allows you to Test Filters to check their effect on the action.

Before/After: In this panel, you can define conditional operations to be performed before or after the execution of the action. This may be sending a message in case of
error, the execution of a script or to exit an application before the execution of the action, the execution of another programmed action, etc.

Common Buttons and information
Ll Preview... Summary... Cancel Save

Graph of the last executions

The button “# at the bottom left shows a graph of last executions, with the duration and the amount copied.
Preview

The Preview... button opens an immediate action with the programmed action settings. You can watch the results of the analysis which will be made by Tri-BACKUP when
running the action.

Summary of settings

The Summary... button at the bottom of the window displays a text of all settings of the action. You can use it to check your settings globally, but also to send the settings to
our technical support if needed.

Save Changes
When the settings suit your needs, click the "Save" button.

If you wish to cancel changes and return to the previous settings, click "Cancel".
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Action panel

[ ] Copy MBP15 HD > HD2 (SSD) (Bootable Copy Editor)

@
E, Action © Trigger ¥ Options K Filters Before/After

A

Action Type: L3 Bootable Copy 2 Color: @ Orange ¢

Action Title: ‘Bootable copy of my startup disk Quick Code:

Comments:

Copy the contents of: To:
& MBP15 HD S - SSD MBP15 HD S
189 GB used (47%) on 400 GB ! Actually 171 GB used on 399 GB
System Mac OS X 10.11.3 [ After copy 189 GB will be used (47%)
Format: GUID partition (Intel Mac) Format: GUID partition (Intel Mac)
This disk can boot a Mac (Intel). Valid for a bootable copy (GUID for Intel)

Destination distributed over several volumes?
Volumes detection mode:

Strict detection (check the volume name, UUID, size and creation date, and if the path exists) ?
° Accept any volume with the same name (if the path exists)

[} Preview... Summary... Cancel Save

The first panel lets you change the type of action and the title that you wish to display (it makes sense to customize the title of each of your actions in order to more easily
identify them when you need to modify them or execute them ).

The Quick Code can be used for manual quick launch of the action, particularly from the Scheduler. See the chapter about Tri-BACKUP 8 Scheduler in the manual Tri-BACKUP
8 (QuickStart Guide).

You can assign a color to display the action (always with the aim of identifying more easily).

A comment box is available. These comments are not used during the execution of the action, but you can use it as a reminder, to inform another user, summarize what the
action is, or specify the terms of use.

The lower part of the panel action depends on the type of action chosen.

For most actions, it shows the source and destination folders or disks.
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Disk (bootable copy)

A popup menu lets you choose among the currently mounted disks, the source (left) and the destination where the copy will be done (right). The area under the menu tells you
the size and variety of information on the selected disk, especially if the source disk contains a system and if the destination format is compatible to make a bootable disk.

Note: The information "size after copy" of the destination disk is given for the case where additional data already present on this disk (and not in the source disk) will be removed (you
can change this behavior in the Options panel).

Folders or drives (other actions)
If you choose a type of action different from the bootable copy (and Alert), one or two areas for selecting a folder or a disk are shown.
You can choose a folder (or disk):

- Drag and drop that folder from the Finder onto the area.

- With the "+" green button if no choice has already been done.

- With the popup menu at the bottom right, by selecting one of the newly defined items or Choose ... that opens the selection dialog.
- With the popup menu displaying the current folder showing the hierarchical path, to choose one of its parent folders.

Copy the contents of:

source e

-
(,

<@ “ MBP15 HD/Utilisateu...rgements/Tri-BACKUP
This volume is HFS formated

The popup menu under the folder icon displays the folder in the Finder and its contents.

The rotating arrow starts a calculation of the current size of the file.

FTP server
For actions where the source or destination is an FTP server, the area shows the server.

You can edit the server information by clicking the edit button in the area (or "+" green button if no choice has yet been done).
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FTP Settings

Server: ftp://ftp.tri-edre.fr
Login: myname
Password: ececcsccccne
Path: private/backupl

New connection for each access
Note: Use this option only if you have problems to access the server.

FTP server is accessible with these settings.

Test
icon.png 4.95 KB 04/02/2014 00:00  rw-r--r--
. Schém...e presse TWXI-XT-X
. Schém...férence TVXE=XT-X

_Schém...ient FTP TVXT=XT-X

- M1IA0 A1 A_AD-OO

Previous Settings g Cancel -O_

Note: In the editor of the FTP server, a "Test" button allows you to verify that your settings are correct to access the server (the server content is displayed in the list).

Detection mode of the volumes
You can choose between two methods of detecting the volumes:

- strict detection of a volume (if two disks of the same name should not be confused). The strict detection checks information of the disk (name, size and creation date of
the disk) to differentiate two discs that have the same name. This is usually the option to choose to avoid confusion between two discs (but it is highly advised to give
distinct names to each of your disks).

- tolerant detection: This mode only checks the name of the disk. This mode can be selected, for example, if you use two alternating backup disks of the same name for the

same action (one for the even days, one for odd days).

Important: Any initialization, repair or reformatting of a drive can change its size and creation date. In this case, if you use strict detection, you must redefine the
items (source and destination) of the actions using this disk.
How is working this detection?

The button -~ on the right in the "volumes détection Mode" box is display data used for strict detection (size, date, UUID). The information indicates stored during
programming of the source and destination data and data read from the found volumes. If there are differences, they are indicated in red.

Tri-BACKUP 8 - Users Guide 49 /77



For example, in the screenshot below, the size of the initial "SSD MBP15 HD" disk is different from the size of the mounted disc, and the UUID (unique volume identifier) is also
different. With a strict detection, Tri-BACKUP will consider that this is not the proper volume (even if it has the same name).

On the other hand, you can use a tolerant detection in the case of backups alternated on two drives of same name and Tri-BACKUP will accept without problem this disk (because of
the same name).
Volumes detection mode:

Strict detection (check the volume name, UUID, size and creation date, and if the path exists) ?
O Accept any volume with the same name (if the path exists)

o [ ] Preview... Summary... Cancel
Next: Tomorrow at 12:35
Detectl!on i%rmatl!on
MBP15 HD (volume mounted) SSD MBP15 HD (volume mounted)
Size: 399 664 451 584 (OK) Size: 249 664 450 560 (399 112 929 280)
ale: 05/10/2013 17:45:04 (OK) Date: 05/10/2013 17:45:04 (OK
UID: 6E233B57-3CDA-32B5-B13B-6B130B3FES24 (OK) UUID: BBBBBFF4-93DB-3D98-A2E2-2409A8B8CE6SD
pa OK (FA6F76AE-BBB2-3778-A87B-1FA616F6E491)

Raw path: Volumes/SSD MBP15 HD (OK

nformation about all mounted volumes are available in the "Volumes" panel of the main window

Automatic mounting of volumes

Tri-BACKUP can automatically mount remote volumes needed to perform an action, either with an alias, or with the "Mount a remote disk" function available in the Before/After
panel.

1/ Using an alias
Note: If Tri-BACKUP mounts a volume using an alias, it will unmount it after the action.

To do this, put an alias of the remote disk, with as name exactly the volume’s name (without additional extension) in ~/Library/Application Support/ Tri-BACKUP 8/Alias/.
You can access this folder using the menu Tools > Access to Settings Folder.

Note: To save the volume password, unmount the remote disk, then double-click the alias and select "Save password in keychain". Thus, the password will not be asked when Tri-
BACKUP mount this volume.

If an action needs this disk (and if it is not mounted), Tri-BACKUP searches in the Alias folder for an alias of that name and, if so, uses it to mount the disk automatically .

Destination |
backups_synoloyithierry [Server/Not HFS] [Alias found (with the same v [ Alias
name as this volume)] (Strict detection. Volume name = E\ backups_synoloy

You can check with the Summary available in the programmed action editor that Tri-BACKUP properly detects the alias (meaning it has been correctly created).
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The alias does not seem to work?
If an alias does not seem to function to mount a volume, check the following:
. Double-click the alias to make sure it works properly (after ejecting the volume, of course). If not, the alias does not work. Re-create another alias that works.
. The alias being put into the Alias folder (in the settings folder of Tri-BACKUP), use the menu "Mount Volumes.." of the Scheduler to mount the volume using the alias. If the
alias does not appear in the menu, it was not placed in the right place. If the volume does not mount, the alias is not functional.
. Finally, check in the summary of the programmed action, that the alias is correctly found (see above). If not, the alias has probably not the correct name.

2/ With the "Mount a remote disk" function
You can use the "Mount a remote disk" function available in the Before/After panel of the programmed action editor (in the "+" popup menu).

+ v
Display a message
Wait a few seconds

Send an email (Pro only)
Play a sound

Execute another action
Launch a file, script, or application
Do AppleScript or shell command...

Mount Remote Volume N

Quit an application
Unmount a Volume
Shut down this machine

You enter in the dialog the information to the remote volume and you can check it with the Test button.
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Condition:

Before the execution of the action <
Mount the remote disk:
Server |P: I‘J28.128.O.1,f‘volu‘we name I
Login: ’ |
Password: ’ |

Test ~ Cancel
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Trigger panel

A programmed action can be launched manually at any time.

Tri-BACKUP offers controls for your actions can run automatically without your intervention to secure your data without having to worry about.

[ NON ) Backup Thierry sur Synology (Mirror Backup Editor)

L | Trigger % Options X Filters

Settings for automatic execution:

Before/After

Execute this action automatically Execution context: Any Context ¢

Execute this action only if all necessary volumes are already mounted
When: Every Day At... C 12:30 o
Custom Programmed Scheduling: + v
When Next
All weeks: Monday Wednesday Friday - 10:00

All months: First day of month - 17:00
With these settings, next automatic execution will be: Today at 12:30
Limitation of executions:

Allow automatic executions only... Prevent manual launch
From: 09:00 s To: 12:00 s Prevent remote control launch

Notification if the action has not been executed for several days:

No (Do nothing) B After days

[ ] Preview... Summary... Cancel Save

The checkbox "Execute this action automatically" allows you to enable or disable the automatic execution of the action.

The checkbox "Execute only if all necessary volumes are mounted" stops execution if the volumes are not present without trying to mount them via aliases (a message
indicates that the action could not be executed). You can define one or more scheduling, but also executions triggered by events (for example, to execute a backup when a
drive is connected, or save documents when you have finished and quit a particular application).

Execution can be limited to a particular Context, such as Home or Office (the current context is selected in the options of the Scheduler - in the Scheduler menu). This allows
you to trigger certain actions when you have chosen a particular context (actions for the House, actions for the Office, etc.).

Predefined triggers are accessible through the menu "When™":

Tri-BACKUP 8 - Users Guide 53177



None of Predefined Scheduling

Every... (minutes)
Every Hour
Every 3 Hours

v Every Day At...

Every Day At first Startup
At each Startup

Every Day At first Shutdown
At each Shutdown

When Volumes are Mounted
After This Application Quits...

After Idle Time of ... (minutes)

The "+" popup menu allows you to add periodic triggers (daily, weekly, monthly, etc.).

Limitation of executions in a timeslot

These options allow you to limit the execution of the action. For example, if you set triggering all hours but you want to limit it in the day between 9:00 and 12:00.

Allow automatic executions only...
From: 09:00 " To: 12:00 "

Protection against unwanted launching
The options allow you to lock the manual launch or the remote launch of the action.

Notification in case of non execution

You can be alerted (message or email) if this action is not executed for several days while his the automatic execution is activated (eg if the conditions of his execution are not
met).
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Options panel

The options are specific to each type of action.

There are however options common to several types of actions:

[ NON ) Backup Thierry sur Synology (Copy Editor)
t" Action © Trigger ¥ Options K Filters Before/After

A

Execution: Execute with full permissions (administrator mode) v

Use this mode to access or copy protected data (System, other users in the machine, etc.), or to copy permissions. Do not use when
accessing a remote disk through a network.

Do you want to copy the attributes of files and folders?

Copy Owner, Group and Permissions

Do you want the files to be compressed, encrypted, or uncompressed during the copy?
No Compression =

Should we delete the files and folders already in the destination and which are no longer in the source?

Delete items from the destination that are not in the source
Delete these items before copying (to free space)
Ask before deleting a large folder (containing more than 20 MB or 50 files)

Extra Settings:

Allow older files to replace newer files
Force Folders permissions to Read-Write (in destination)
Compare each file with the original after the copy (this is a double check)

[} Preview... Summary... Cancel Save

- Execute with the current user / Administrator permissions: With Administrator mode, the entire disk is available, including the System and the accounts of other users.
With the permissions of the current user, other accounts may not be copied nor the System.
Note: We usually use the "current user"mode unless if you want to copy the data to all users. Administrator mode is automatically activated if you choose a "Bootable Copy" action.

- Copy owner and permissions: Every file and folder has an owner and permissions. You can choose to copy these attributes (in this case, you must set the Execute with
Administrator option), or conversely to have the default attributes (the copy will have the current user as owner).

- Compression: You can choose to have every file saved or copied as compressed (which reduces the size of the backup) and possibly encrypted with a password (the
recovery of each file can only be done if you have the password which was used to encrypt the file).

Note: Compression and encryption routines are proprietary. Tri-BACKUP is necessary to restore the original file.
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- Delete: If the folder (or disk) destination already contains items that are not in the source folder (or disk), you can delete them or not. Delete gives an identical copy of the
original, but any error made on the original will be reproduced in the destination.

Note: For Bootable Copy actions, you can choose not to delete the folders already present on the root of the disk (eg if the destination disk already contains data that you do not want
to delete during the creation of a bootable copy).

- Replace newer files: Normally, recent files replace the old files, but it may be useful to replace a file by an older version (eg if in the original file is reverted to an earlier
version of a document). This option authorize the replacement.
Options to create a minimal System

For actions of type Bootable Copy, you have an option to copy only the bare minimum to achieve a functional minimum System. You can make a rescue disk or an USB key
where you can then install the utilities of your choice.

This minimal system will occupy 10 to 20 GB on the destination volume (the size will depend on the contents of your system).
Note: In the Filters panel, you can add filters to the action to exclude unwanted items, languages, etc.
Other options
For Evolutive Backups, there are specific options for the keep life of data (given that the latest version of each file is always preserved).

Specific settings for Evolutive Backup:
Make Evolutive Data visible

Remove older versions after: 30 Days

Retain a maximum of: 4 Versions

For Incremental Backups, you can set after how long - or how many executions - backups are deleted.

Specific settings for Incremental Backup:

Partition the Backup in folders with a maximum size of: MB
Remove previous backups after: 7 Days
Remove previous backups if more than: 10 Backups

For Synchronization, the action normally copy the recent files and files that are missing. You can change the behavior of this action:
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Specific settings for Synchronization:

Synchronize by comparing the contents of each folder

<>

© Copy missing files in both directions
Copy missing files from left folder to right folder only
Do not copy missing files (update existing files only)

Synchronization replaces older version of each file by the newer version.

If a file is only on one side (and missing on the other), it will be copied to the other side. Any file deleted on one side will be
copied again (if it exists on the other side).

You can use two modes of synchronization (from the popup menu):

- Direct synchronization (Synchronize by comparing the contents of each folder) compares the content to replace the old files with new ones, and copy the missing files. The
options provide different behavior for the missing items.

- Synchronization of changes (Synchronize by comparing the changes since the last synchronization) compares the current contents of each folder with the previous
contents to detect what has changed. The items modified, added or deleted on one side since the last synchronization are copied (or deleted) on the other side.
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Filters panel

The filters are used to exclude certain items of a copy or a backup.
There are a number of predefined filters, such as .DS_Store (which contain the settings for each file format), aliases, invisible items or the contents of the Trash or Caches.

You can exclude languages resources keeping only one of your choice (in addition to English, which is always preserved).

You can also create an exclusion list of files or folders based on their name, size, etc.

Note: The items excluded are ignored: they are copied or deleted.

Copy MBP15 HD > TR System (Bootable Copy Editor)

B Z Action Trigger Options Filters Before/After Summary

Exclude .DS_Store files Documents only
Exclude Aliases Exclude Evolutive Backup data

~ Exclude Invisible Exclude Caches, Logs, Virtual Memory, MobileBackups, etc.
Exclude the contents of the Trash Do not create empty folders in copy

-

Exclude files modified before the last execution: --> 30/08/ 2017 a 15:06:54 v

Languages: Keep All Languages (all localization resources)

Disable all the filters when analyzing within |dentified packages (applications, bundles, etc)
Disable filters in Folders/Bundles with one of these extensions:

Use the filters below (specific for this action): +
Mode Name Extension Label Size Madification date

@ [ is “TrashMagic2Cache"

Use this set of Common Filters: No Set of Common Filters selected < Test Filters
(defined in the Tools menu)
Number of executions: 1 882

Last: Today at 15:06
Next: Tomorrow at 12:45

Ll Preview... Cancel Save
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Disable filters: If you wish that the filters do not apply when copying the contents of applications, bundles, or folders with an extension (for example, unidentified packages),
you can check boxes to disable the filters. This allows you to have complete applications or databases, regardless of the filters.

To add an item in the list of filters, you can:

- Drag and drop a folder or file on the list: It will automatically be taken as a reference for the filter.
- Click the "+" button: The filter editor will open.
- Drag and drop a filter for the edit window of another action (or from the window of the common filter).

To edit an existing filter, double-click the filter in the list.
You can add as many filters as necessary. The execution of the action will only process files and folders that are not excluded by a filter.

The "Test filter" button will display a window showing for each item in the folder (or disk) source, whether it is excluded by filters or not.

Common filters

With Tri-BACKUP, you can create sets of filters that you can use for various actions. Changing a set of filters modifies all the actions to which it applies.
The edition of the common filters is located in the menu (or panel) Tools.
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Filter Editor

The edit dialog displays various filter options:

Filter Mode:

@ O Exclude matching items
(+) Include only matching items

Type of items:

All (Files and Folders)
Files
- O Folders, Bundles, Packages...

Items with path, name, extension and label matching:

<>

The name starts with o exactly...
.Trash
The extension is one of these:

The label is: (] None

<>

Files with size and modification date matching:

The size is smaller than... KB
The modification date is older than... 28/ 1/2016 11:35
Choose Example... Cancel “

- Filter Mode: A filter can be used to exclude certain items (eg exclude all files that are larger than 10 MB) or instead to include only some items (eg copy only files with the
extension "jpeg ").

- Type of items: You can choose a filter applying only to folders or files.

- Name and extension: Here you specify the criteria for detection of items involved in the filter.

- Criteria on files: You specify the criteria in the area to filter depending on the size and modification date.

Note: The criteria of size and date do not apply to folders.

The button "Choose Example" takes a file or folder as an example, and copies the information of name, extension, size and date of the example.
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Before / After panel

You can perform conditional operations before or after the execution of the action, such as sending a message in case of errors, launching another action if this action was
successful, unmount a disk or launch a script or application after the action.

For example, you can mount a disk image, perform a backup in this disk image and unmount it at the end of action, and send an email if errors have been detected.

[ ) [ ] Copy MBP15 HD > TR System (Bootable Copy Editor)

E: Action © Trigger £ Options K Filters Before/After

If errors or problems are encountered during the execution of this action:

Display a message if errors
Display the list of errors at the end of the execution

Things to do before or after the execution of this action:

Message... Launch... Unmount... Shut Down... 4+ v |
Condition To Do Display a message
Wait a few seconds
Before Launch: TR System.sparsebundle R
) h Send an email (Pro only)
After if errors Send an email to: trolland@me.com
Play a sound
After Unmount: TR System

Execute another action

Launch a file, script, or application
Do AppleScript or shell command...
Mount Remote Volume

Quit an application
Unmount a Volume
Shut down this machine

—

[} Preview... Summary... Cancel Save

xt: Immediately

The "+" button displays a menu to select the operation to perform.

In the editor, you can choose from the popup menu the condition for the operation to be performed: before or after the execution, in case of error or when copying files, etc.
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Immediate Actions

Immediate actions are intended to visually check the condition and contents of two folders or control what you want to copy or delete.

It is recommended to reserve the use of immediate actions for verifications and specific operations. For overall performance as well as for global copies, it is best to
use a programmed action.

Opening an immediate action

You can create an immediate action from the Actions menu. Select one of the desired type:

New Immediate Action X #EN
Immediate Copy ¥>
Immediate Synchronization ®BY |

Immediate Copy to FTP Server
Immediate Copy from FTP Server

Immediate Create MagicProfile
Immediate Sync with MagicProfile

Immediate Restore

Immediate Compress #K
Immediate Uncompress 08K
Delete Contents *-

Modify Owner, Visibility...

Calculate Size of Contents
Compare Folders Sizes
Compare Folders Contents

You can also open an immediate action using the settings of a programmed action (use the "Preview" button).
You can reuse an immediate actions already saved in the Immediate Actions Panel.

This will open a window for the immediate action.
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Window of an immediate action

Opening an immediate action opens a window displaying the contents of the selected folders and information for comparison and possible operations.

[ ] O Immediate Action [Copy Folder]
Action Type: T3 Copy Folder = _
Copy the contents of: ? To:
[ source v » | source v
C (click to get the size) C (click to get the size)
<@ a MBP15 HD/Utilisateurs/...ts Cocoa/Tri-BACKUP 8 22 @ a MBP15 HD/Utilisateurs/...ts Cocoa/Tri-BACKUP 7
This volume is HFS formated \}_]:\/ This volume is HFS formated
Drag and drop a folder or a disk, or. - v Drag and drop a folder or a disk, or. - v
&
Show invisible items © show all items
Display real name (not localized) ") Show only items that are different
v common =53 | common
h Constants.h = h Constants.h
ConstantsNotification.h =, [ ConstantsNotification.h

h] HUDBackgroundView.h
m HUDBac

h] HUDBackgroundView.h

I

<groundView.m m HUDBackgroundView.m

6.41 KB (6 405) - 08/12/2015 16:38:39 DA 6.21 KB (6 213) - 04/12/2015 16:56:31
Owner:thierry (501) - staff (20) - Read and write (-rwxr-xr-x) >4 Owner:thierry (501) - staff (20) - Read and write (-rwxr-xr-x)
¥  Settings... Hide the items excluded by filters Analyze...
o> Copy Delete items from the destination

if they are not in the source

Action Type
At the top (in the black band) is a popup menu to choose the type of action.
If you change the type of action, the settings and the buttons are modified (if necessary) to accommodate the new type.
Note: If the settings are compatible, they are kept (for example, a "copy" action changed to "synchronization” will take the same folders but the buttons at the bottom and the
presentation of the list will be changed).
Areas of folders selection

Below the menu are areas where you can choose the folder (or disk) to process. You can drag and drop a folder or disk on one of these areas, or use the popup menu at the
bottom right in the box to select the desired folder.

Note: The menu offers a list of folders or disks you have recently viewed.
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Areas navigation buttons

The buttons between the zones can update the contents, switch source and destination and go up or down into the hierarchy.

Display options
Show invisible items: This displays (or hides) the invisible files and folders in the list.
Display real names: This option displays (or hides) the real names (not translated).
Note: Mac OS X automatically translates certain folder names when displaying the Finder windows (for example, "Library" will be translated).

View All / Only differences: The items identical in both cases are normally displayed in gray. With this option, you can hide them so that only the differences in the list are
displayed (this reduces the content of the list making it easier to find items to be copied).

Hide the items excluded by filters (bottom): The settings allow you to add filters to exclude certain files or folders. This displays (or hides) the items excluded by these filters.

The list of contents
The list shows one or two columns (depending on the type of action) and presents the content in the form of hierarchical list sorted alphabetically.

When the list displays the contents of two folders (i.e. with two columns), Tri-BACKUP displays on the same row items of the same name on both sides. If an item is present only
in one folder, it is only displayed on one side. The center column displays information as icons (same or different items, etc.).

Certain actions (delete, compress, etc..) only shows one column. The list displays the contents on the left and information icons on the right.

Information on selection

When an item is selected in the list, the size, date, owner, etc.. are displayed at the bottom of the list. If a folder or a package is selected, Tri-BACKUP shows its size and the
number of items.

Note: Differences are indicated in red. For example, if a file is selected and is present in both folders (then displayed in two columns), a size in red indicates that the sizes of the two
files are different.

Settings and execution buttons

At the bottom of the window are buttons for various settings and the execution of the action. These buttons are dependent of the type of action chosen.
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Settings
For immediate action, you have the same options and same filters as for the programmed actions. Click the Settings button to open a window for editing the settings.

See the guide of the editor of programmed actions for more details.

Note: Some tabs are grayed out in the editor (as trigger) because these settings are not available forimmediate action.

Analyze

Immediate actions allow you to launch an analysis of the selected items. The analysis does not change the contents but displays items that should be copied or modified if you
launch the execution of the action.

[ ) [ ] i Results
Analysis: 83 092 items (21.0 s)
Copy: 0
Replace: 3 (12.21 MB)
Delete: O

Al B 2l
o> Tri-BACKUP 8.pages
o> .DS_Store
L Tri-BACKUP 8.pages

During an analysis, the output window shows the summary and found items (with an icon for the type of operation to do for this element).
Note: You can display (or hide) the window by the button "Results" in the upper right corner of the Inmediate Action window.

The results window contains a menu and a search field to display only certain items.
If you click an item in the list, it is displayed in the main list of Inmediate Action.

Execution of an action

Select from the list files and folders that you want to perform operations, and then click the button corresponding to the chosen action (if multiple buttons are present) at the
bottom of the window.

Note: As with the analysis, the results window shows a list of items processed.
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Tools

Duplicate Partitions Map...

A disk contains one or more partitions. With this Tri-BACKUP tool, you can easily recreate a new disk with partitions similar to those of another drive, including hidden System
partitions.

[ NON | Duplicate Partitions Map

Create a destination disk by duplicating the scheme of partitions of an existing
source disk.

Source Disk: Destination Disk:

disk0 (1.00 TB, 5 partitio... g disk2 (1.00 TB, 3 partitio..fg &

Adapt the partitions in the destination if the sizes of the disks are different:

Resize last partition only in destination

Copy the contents of hidden System partitions (Boot OS X, Recovery HD...)

ID Partition Size New Format
disk0s2 MBP15 HD 400.00 GB 400.00 GB Apple_CoreStorage
disk0s3 Recovery HD 650.00 MB 650.00 MB Apple_Boot
diskOs4 B TR Data 599.56 GB 599.21 GB Apple_CoreStorage
disk0s5 Boot OS X 134.22MB 134.22 MB Apple_Boot

Resized (-350.70 MB). Format changed (Journaled HFS+).

The destination is smaller than the source (351 MB). Partitions will be reduced in
destination (see size in red in the list).

Connected Disks... Duplicate

With the popup menus, you select the disk which will serve as a reference for the organization of the partitions, and as destination the disk which will be deleted to create the
same partitions scheme as in the source disk.
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If the disks have different sizes, the created partitions will be adapted accordingly (enlarged or reduced), except the hidden System partitions which retain the size of the
original. Sizes are displayed in the list.

The format of the new partitions will be identical to the format of partitions from the source disk, except the encrypted partitions that will be journaled HFS.

Copy contents: You can copy the contents of the hidden System partitions on the new disk.

CAUTION! All data of the destination disk will be deleted.

Copy Hidden Partition Contents...

Some hidden system partitions (as Recovery HD, Boot OS X, etc.) are never mounted on the Desktop and cannot be easily copied. With this Tri-BACKUP tool, you can easily copy
the contents of a hidden System partition on another partition (including a hidden partition).

O Copy Hidden Partitions

Copy the contents of a hidden partition (Boot OS X, Recovery HD, etc.) to another
partition or a folder.

Source Partition:

diskOs3 (Recovery HD, 650 MB) [T &
Destination:

disk5s3 (Recovery HD, 650 MB) ﬁ
Connected Disks... Copy

The "source" popup menu indicates the various hidden partitions found on the drives currently connected.

Depending on the choice of the source partition, the "destination" popup menu offers the corresponding destinations. Alternatively, you can select a folder or a disk (or a disk
image) where the data will be copied.

Create Recovery HD Partition

The Mac OS X Installer creates by default a partition named "Recovery HD" on the startup disk. This partition is hidden in the Finder, as well as in Disk Utility. This partition is
used to reinstall Mac OS X, but is also required to enable FileVault protection. If you create a bootable copy of your disk to an external disk, you need to install a "Recovery HD" if
you wish to activate FileVault.

Tri-BACKUP 8 - Users Guide 67 /77



Tri-BACKUP allows you to create this Recovery HD partition on a drive, and copy the contents of an existing Recovery HD partition. The function is accessed through the Tools
menu.

[ NON Create Recovery HD Partition
Recovery HD is not mandatory but is required if you want to have a crypted Bootable Copy (FileVault) on
the same disk.

To create a Recovery HD, select an existing partition. Its content will not be changed, but its size will be
reduced. The Recovery HD partition will be created on the freed space.

ID Name Size
1.0 TB The disk already contains a Recovery HD partition.
Recovery HD 650 MB
d &l MBP15 HD 400 GB Encrypted partition
d 1.0 TB No mounted partition available
d & TR Data 599 GB Encrypted partition
d & HD Time Machine 1000 GB Encrypted partition
disk5 64 GB

You can create a Recovery HD. The contents of the partition will remain unchanged but its size will be
reduced (by 1 GB) and a new partition will be created for the Recovery HD.

Use this Recovery HD as the source: = diskOs3 a

Connected Disks... Create Recovery HD

The window displays a list of existing partitions. To create the partition Recovery HD, Tri-BACKUP reduces the size of an existing partition (of about 1 GB) to free the place where
the new partition will be created.

The popup menu at the bottom of the window lets you select the Recovery HD reference (the partition from where the data for the new Recovery HD will be copied).

Important: This operation will change the structure of the destination disk, and it is recommended to make a BACKUP of its contents before you create a Recovery
HD partition.

Note: You cannot change the current startup disk.

Note 2: If you select an existing Recovery HD, you can update its contents (that is, to copy the contents of the selected source).
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Tri-BACKUP 8 Scheduler

This application runs in the background and triggers the execution of programmed actions. It is also the main point to control backups when the main application Tri-BACKUP 8
is not launched. You can start or stop actions and monitor their execution.

Itis visible only by its icon in the menu bar. Click the icon: ﬂ

& Open Tri-BACKUP 8...

%% Preferences (Tri-BACKUP Scheduler)...

st GoTo >
F2\ Mount Volumes... >

8 Execution Status, Context, Options...
@© Pending Actions...
[»] Launch Programmed Actions... »

No action scheduled
Disable Automatic Execution
Suspend Execution

© Latest Notifications... >
© Information... >

Next actions
@wP 15:00 Backups pour Dropbox
S5 17:15 Copie Fichier Clients 3 (dans DropBox)
29/01/2016 07:50 Copy Emails Boutique
29/01/2016 08:15 Copy MBP15 HD > X4-2...
Actions executed today
B 14:15 [0:04] Copie Fichier Clients 3 (dans DropBox)
13:17[22:34] Copy MBP15 HD > TR System
@ 13:16 [0:46] Copy Data > TR Data Copy
13:15 [0:26] Copy Data > HD2 (SSD)
| 13:06 [9:24] Copy MBP15 HD > HD2 (SSD)
@ 12:52 [5:07] Copy Data > TR Data Copy / CANCELLED: volume not found
| 12:46 [5:19] Copy MBP15 HD > TR System /| CANCELLED: volume not found
12:41 [5:06] Copy Data > HD2 (SSD) / CANCELLED: volume not found
| 12:35 [5:06] Copy MBP15 HD > HD2 (SSD) | CANCELLED: volume not found
“w\ 12:25 [0:05] Copie Data Encrypted to DropBox
W= 11:15 [0:04] Copie Fichier Clients 3 (dans DropBox)
s 08:45 [1:32] Copy Data > X4-2
More Actions...

g

FEvEbaavy &

Quit Tri-BACKUP 8 Scheduler
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Clicking this icon access the various controls of the execution, and in particular, you can:

- Open the main application Tri-BACKUP 8.

- Open the Preferences dialog of Tri-BACKUP 8 Scheduler (display of the icon in the menu bar, displaying information during execution, display messages, etc.).. With these
preferences, you can make the execution of actions very discreet, or otherwise have all the tools to monitor their execution).

- Mount volumes (if alias of these volumes are in the folder ~/Library/Application Support/Tri-BACKUP 8/Alias/), for example for the execution of an action.

- Execution Status, Context, Options...: change the status of the automatic execution of programmed actions (eg to temporarily disable the automatic execution of
actions) and the execution context (for example, when you're traveling with your laptop, so that only certain actions will be triggered automatically.)

- Pending Actions...: View and modify the list of actions awaiting execution.

- Launch Programmed Actions...: Manually start the execution of a programmed action or of a group of actions.

- Disable Automatic Execution: Disable or enable the automatic execution of programmed actions.

- Suspend or stop the programmed action in progress.

In this menu, you also have the history of last executions and next actions.

Disable automatic execution of actions

If you wish to interrupt the automatic execution of scheduled actions, you can:

- Suspend (the current execution is paused): The current action temporarily stops until you resume normal execution of this action. Other actions of the queue are
themselves also put on hold.

- Disable automatic execution: The current action is completed, but the following will not be executed.

- Disable after completing pending actions: The current action terminates, and all actions that are in the queue. No new action is added to the queue.

Note: The icon in the menu bar is grayed out if the automatic execution is disabled.

Change the execution context

The current context is changed in the Execution Status window (in the Scheduler menu).

Each programmed action can be set to run automatically in a particular context (Office, Home, etc.).. For example, if you brought your laptop at home, you may want only
certain actions can run automatically. In this case, change the context for Home and only actions set with a Home context (or all contexts) will be executed.

Note: You can manually launch any of the actions (context intervenes only for automatic executions).
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Execution of actions by a keyboard shortcut

You can manually launch a programmed action at any time through a keyboard shortcut that will open a launch window (Tri-BACKUP 8 does not need to be launched).

You set the keyboard shortcut in the preferences of Tri-BACKUP 8 Scheduler. For example, if you set the keys "Ctrl + right arrow" as a shortcut, you press both keys

simultaneously (at any time and from any application) to make the launch window appear, where you can choose the action to launch in the list (possibly after filtering by
name or quick code assigned to an action or a group).

Note: You can assign a quick code for each action or group to find and launch it quickly.

Example: You have assigned the code "bk3" to a group containing three actions. Type the shortcut to bring up the launch window, then enter "bk3" in the search field and hit "Enter”
to launch these three actions.

Errors Summary

If errors occurred during the execution of actions, a message is displayed with the date of the last problem and the number of problems:

(] Error Summary (Tri-BACKUP 8)

Latest errors or interruptions:

gk 1 action completed with errors.
——

Display if errors or interruptions

Clear Show

The Show button shows the action in the Last Actions panel of the main application.

You can disable this message by clicking the Clear button (until next error), or by unchecking the option (to no more show this message). You can have this message displayed
again in the Information... submenu of the Scheduler menu.

Preferences of the Scheduler

You can access the Preferences by the menu or by the Preferences of Tri-BACKUP 8.
The following window is displayed:
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Preferences (Tri-BACKUP Scheduler)

Predefined behavior settings > Unobstrusive
Messages

Show Welcome message at startup
Show messages in Notification Center

Default

Surveillance
Miscellaneous

Automatically stack windows
Wake up the Mac to execute the actions

Alert if free space on the startup disk < 10%
When an action is executed
Su olumes/ folder
Display the list of pending actions .
pay P 9 Alert if /Volumes/ folder contains incorrect data

Display the mini floating progress window H
Display the main progress window ETa e A T RS
Report when a volume is mounted/unmounted . .
Keep actions in gueue when computer shuts down
Icon in the menu bar f checked, the pending actions at n (actions not yet
cuted) will be executed at the next reboot
@3‘ Always visible H
Latest Actions Quick View o
Always visible 3
...... u Set
Transparency: . & Clea
r
Transitory Messages
White (text) Bl (back i) . Transparency: Remote Control
ite (tex ue (background) & 0 o D0 .
9 H (¥ Allow Remote Control (by another machine)
Click to select a position --> om o= o Local Name: MBPro 15 Retina Thierry
(or drag the messages window to change the desired o o= o=
position) - o o Password (to access this Mac):
Cancel -o]-

On the left you have the display options. They allow you to closely survey the activity of Tri-BACKUP or on the contrary to be the least disturbed possible. The buttons at the top
of the window are presets, from "Unobstrusive" (you will not be disturbed) to "Surveillance" (you can check all activities). These predefined settings can then be tailored to your
own needs.

Show posts in Notifications Center: Messages are displayed using the notification system in Mac OS X.

Display the progress in a mini window: Show the progress in a small window.
>  Copy MBP15 HD > TR System BN Ao .

Display the progress window: Show the normal progress window of Tri-BACKUP Execute.You can also view the progress by clicking on the icon Tri-BACKUP Execute in the
Dock, during the execution of an action.

Icon in the menu bar: Offers various possibilities to display the icon in the menu bar. If the icon is always hidden, you can open the Preferences by Tri-BACKUP 8 (button

in the Preferences window).
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Latest actions Quick View: A small window displays the status of the last executed actions: the time their were executed, and the global result (normal, errors, interruption).

On the right, you have the other settings of the Scheduler, and in particular:
Wake up the Mac: The Mac is awake if its activity is suspended and whether action should be executed. If the Mac is switched off, this option does nothing.

Alert if free space too low: Survey the free space on the startup disk.
Survey the contents of the /Volumes/ folder: If incorrect elements located in the system folder it can be automatically cleaned or you can be alerted.
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Tri-BACKUP 8 Execute

This application is launched for every execution of a programmed action. Its icon appears in the Dock with a progress bar indicating its progress.

Tri-BACKUP 8 Execute

You may at any time, by clicking on the icon, display the progress of the execution of the action, or stop it.

Progress Window

This window allows you to monitor the current action. It shows the folder being analyzed, the number of items compared and copied, and the space available in the destination
disk.

[ JON ) Executing Copy MBP15 HD > HD2 (SSD)

MBP15 HD/Applications/Messages/Contents/Resources/ru.lproj

93 358 MB 1mn 38s - Remaining about 10mn
2 46 KB 312995 (19 GB) 1962 419 (192 GB)
L |
227.46 GB Skip... Pause Stop

You have 3 buttons in this window:
Skip ...: This function allows you to record running.
Pause: Pause the execution (the button becomes "Continue" to resume execution).

Stop: Stops the current action. The current position is stored, and at next execution, you will be asked if you want to resume from that position or start over.

In case of missing volume

At the launch of the action, Tri-BACKUP checks if disks (source and destination) are mounted. If not, it tries to mount them via their alias (see paragraph on the alias).
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If one or more volume are missing, a window is displayed to indicate this lack and leave a few minutes to mount the volume (or choose another). The Show Volumes button
displays the mounted volumes and difference criteria to help you to detect the cause of the problem.

Unmounted Volume

Volume SSD MBP15 HD is not found. Please,
mount it to execute this action.

None of the mounted volumes has the expected name.

If the missing volume is mounted, the action will continue
automatically.

You can Choose another disk/folder, or Abort this action.

Show Volumes displays information about mounted volumes and
detection criteria.

Action aborted in 4 mn 41 s.

[ Show Volumes ] Aport Choose...

Mounted Volumes Inforn

Tri-BACKUP did not find a volume/folder required to execute the
current action.

The path does not exist on none of the mounted volumes.

The searched volume must meet these criteria:

Name of the volume: SSD MBP15 HD

Full path: /Volumes/SSD MBP15 HD

Size and creation date of the volume are not verified (a tolerant
detection was chosen).

List of currently mounted volumes (for comparison with the one
desired):

1 - Name of the volume: MBP15 HD / <different>
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Icons meaning (Help menu)

(%) Icons Meaning

oakhwmmwg’i:‘

Y

»%S’&EW@“@‘ le@BOD ] X B @<

2

Trigger activated
Trigger deactivated
Execute with admin privileges

Copy file or folder

Replace existing file

Replace newer file

Copy folder contents
Synchronize folders contents
Compress file

Uncompress file

Delete file or folder

Copy Owner/Permissions
Modify file or folder
Protected item (Time Machine etc.)
Compare files

Items excluded by filters

Executed successfully
Executed with errors
Executed with errors
Execution interrupted

Identical

Different contents

Missing items

Different dates

Different Owner/Permissions
Different Tags

Active (automatic executions)
Active (Trial mode)

Disabled (no automatic executions)
Disabled (boot disk has changed)
Executing a pregrammed action

Execution paused
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Error Codes

Errors are displayed with a code which you can find the meaning below:

E1 - Error: File not found (there was no file at this location)

E2 - Error: Insufficient free space in the volume to complete the operation

E3 - Error while reading the file (unable to read file information or contents)

E4 - Error copying file (unable to create the folder hierarchy or to copy the file at destination)
E5 - Error deleting file (unable to delete a file)

E6 - Error renaming file (unable to change the name of the file)

E7 - Error copying file's attributes (unable to set the correct attributes, owner or permissions)
E8 - Copy aborted by user

E9 - Files have not the same contents

E10 - Error creating or opening stream for FTP access

E11 - Error creating or opening stream for FTP access

E12 - Error with proxy, username or password for FTP access

E13 - Error with proxy, username or password for FTP access

E14 - Error with proxy, username or password for FTP access

E15 - Error: File not found (there was no file at this location)

E16 - Error creating destination

E17 - Error time out exceeded (FTP access)

E18 - Copy aborted by user

E19 - Error: Types are different (replacement of a file/folder by a folder/file is not allowed)
E20 - Files have not the same date

E21 - Files have not the same permissions

E26 - The source or destination path is incorrect
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